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Using “Audacity®” for language teaching 
 
Audacity is a tool for creating and editing audio files (downloading and editing podcasts, recording interviews, creating personal 
audio messages, etc.). 
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This DOTS activity discusses how the use of free sound editing software such as Audacity® has great potential for second and 
foreign language teachers who can create custom audio resources and design oral learning tasks for their students. It is buil t in a 
modular format, so that you can use one or more of the sections, depending on your needs and the time you have available. 
 

What can I do in this activity? 
Where can I find the information? 
(click on the link to go to the section) 

PART 1  

Find out about what Audacity® can do 
and how people use it 

A. What is Audacity®? 

Think about some pedagogical 
reasons why I would want to use 
Audacity® for my teaching 

B. Why would I want to use 
Audacity® in my teaching? 

 

PART 2  

Learn about how Audacity® works 
C. Some basic features of 

Audacity® 

What I need to keep in mind when 
using Audacity® in my teaching? 
Explore some pedagogical issues and 
read a sample activity. 

D. Pedagogical considerations and 
sample activity 

 

Find out about some easy and more 
advanced technical steps to help me in 
using Audacity® in your teaching. 

E. Practical suggestions 
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PART 3  

Check my understanding using a quick 
and easy checklist 

F. Check your understanding 

Think back over what worked and 
what didn’t work (in the DOTS activity 
and/or in my use of this tool) 

G. Reflect! 

Check out what other teachers do with 
Audacity®.  
Discuss and evaluate ideas and 
activities in a DOTS forum. 
Create additional tasks and share 
them with colleagues online. 

H. Explore and share! 

Consider my students’ privacy when 
using Audacity®. 

I. Protecting your students’ privacy 

PART 1 

A. What is Audacity®? 
 
In this section you will find out what Audacity® looks like and how people use it. If you decide to use it for your class, it will be 
helpful to know some basics. 
 
Audacity® is a free, open source software that enables you to record and edit audio, mix it and export it in a format that you can 
use in your teaching (e.g. for listening, pronunciation or production activities). 
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It is distributed under the GNU General Public License (GPL), which means that you can use it for any personal, commercial or 
educational purpose, including installing it on as many different computers as you wish.  
 
It is available for Mac OS X, Microsoft Windows, GNU/Linux, and you can download it from the net at 
http://audacity.sourceforge.net/   
 
With its user-friendly interface Audacity® enables teachers to create oral activities for face-to-face and/or online language teaching 
environments (i.e. pronunciation, listening comprehension and oral production activities) by: 

 recording live audio  
 recording Podcasts and audio clips from the Internet 
 editing audio files (cut, copy, paste) 
 mixing sounds together  
 applying different effects on the audio file (such as changing the speed or pitch of a recording, removing noise, amplifying 

sounds) 
 converting old tapes and records into digital recordings or CDs.  
 exporting audio files in formats such as MP3, WAV, AIFF or Ogg Vorbis 

 
 

B. Why would I want to use Audacity® for my teaching? 
1. Because it allows you to expose students to a diversity of authentic L2 audio resources. 

 You can record radio programs (or the audio track of a TV program), music and songs from ITunes, Podcasts and audio 
clips from the Internet, authentic interactions between native speakers, etc. and easily develop listening comprehension 
activities using the editing tools of Audacity®. 

2. Because it enables you to continue to use analogue resources in a digital environment. 

http://audacity.sourceforge.net/
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 If you have been teaching for a while, you have probably developed a collection of interesting audio resources on tapes 
over the years. Audacity® allows you to digitalize all these analogue resources for easier, more flexible and more diverse 
uses (for instance, you can share them with your students and your colleagues more easily, edit them, etc.). 

3. Because it allows you to develop custom pronunciation activities. 

 Using the editing and the sound effects tools of Audacity® (cutting, copying, and pasting audio clips, changing the speed 
or pitch of a recording, removing noise, amplifying sound, adding silences), it becomes very easy to create activities 
specific to the pronunciation needs of one or several students, in a face-to-face or online environment. 

4. Because it supports the development of metacognitive skills and strategies of your students. 

 Students can easily listen, visualize, and compare all or very specific parts of their (or their peers’) recorded productions. 
They can save their oral productions to listen to them again later on and assess/monitor their progress (as part of for their 
student portfolio). 

5. Because it encourages creativity. 

 Teachers AND students can easily create audio and musical documents in L2. 
6. Because it facilitates a task-based approach to learning 

 It allows students to learn the language while creating original audio resources (learning by doing). 
7. Because it appeals to the students – this technology is part of their world. 

 For instance, your students are likely to have used Audacity® to export songs and audio files in MP3, edit audio files, or 
mix sounds together for their mobile devices. 

 
Just like with any other classroom material, you need to keep the pedagogical considerations in mind (e.g. learning objectives, 
authenticity, language focus, task-based approach, etc.). To explore these in more detail visit section D: Pedagogical 
considerations and sample activity. 
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PART 2 

C. Some basic features of Audacity® 

 
In this section you will find out about: 

 What you will need to do to start using Audacity®, 

 What you can do with Audacity®, 

 Where to find more help. 
 

What do I need to do to start using Audacity®? 
In order to use Audacity® you will need to download it and install it on your computer. Once you have downloaded it, you will need 
speakers or headphones if you decide to use existing audio files that you already have on your computer or that appear online. If 
you decide to record yourself you will need a microphone. You may also decide to use a keyboard or some other sound input 
device.  
 

Downloading and installing Audacity 

To visit the site, just click on the following link: http://audacity.sourceforge.net/ 
Downloading Audacity® and installing it are both straightforward operations: 
Just click on this link http://audacity.sourceforge.net/download/ and choose the operating system that you are running on your 
computer (Windows, Mac or Linux). 
 

 
 
 
 

http://audacity.sourceforge.net/
http://audacity.sourceforge.net/download/
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The complete versions are listed on the left hand side, and the versions on the program still being tested (called Beta versions) are 
available on the right hand side. We recommend using the latest complete versions (on the left-hand side) if you are a first-time 
user.  
 
If you click on “Windows” on the left-hand side, the following screen appears: 
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You need to click on the link (“Audacity 1.2.6 installer” in the picture above) which appears under the heading Recommended 
Download. Once you do that a dialog box will appear: 

You need to click on “Save File”, which will enable you to save the file on your computer. Another dialog box will appear, similar to 
the next one: 
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You need to click save, but keep in mind that you need to remember the location on your hard drive where you saved it. For 
instance, in the picture above, the file called “audacity-win-1.2.6” will be saved in C://. 
To install the program, just go to the location where you saved the program, and double click on the saved file. Your computer may 
ask you whether you are certain you want to run the program, and in this case just click on Run. This will begin the installation 
process, and you will be guided through the remaining steps by dialog boxes appearing on the screen.  
 
If this installation process sounds too daunting, do not be discouraged! It does not take very long, and it is quite straightforward. It is 
well worth doing this, because of all the things that Audacity® enables you to do. 
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What can I do with Audacity®? 

 
Audacity® allows you to: 

 edit existing audio files in various ways,  

 record your own audio files,  

 share your files with your class.  
 

Editing an existing file 

Perhaps the simplest way to start is to open an existing audio file that already appears on your computer (you can find more on this 
here: http://manual.audacityteam.org/man/Tutorial_-_Editing_an_Existing_File).  
Click File > Open and locate the file on your computer. 
 

Try it out! 

If you are currently online, you can go to the 
download page at: 
http://audacity.sourceforge.net/download/.  Once 
the program is installed, you can start straight 
away by trying out the basic functions of Audacity 
in a trial-and-error method, or you can access the 
online user guides. 

http://manual.audacityteam.org/man/Tutorial_-_Editing_an_Existing_File
http://audacity.sourceforge.net/download/
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Once you have opened a file, a screen similar to this one will appear: 
 

 
 
The row of blue lines is a visual representation of the audio file. You can now use the toolbars and menus to try out some of the 
things that Audacity® allows you to do. Remember that you can actually drastically change how the file you are working with 
sounds, so always work on a copy of a file that you do not mind changing.  
 

Basic toolbars 
1. Control toolbars:  
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Although quite intuitive, the meaning of each button can be found on this webpage: 
http://audacity.sourceforge.net/onlinehelp-1.2/toolbar_control.htm 
 
2. Edit toolbar 
Here again the buttons are quite intuitive:      
 

 
 
http://audacity.sourceforge.net/onlinehelp-1.2/reference.html#toolbar_edit  
 
You can now start playing with the toolbars and see what results you can get. For instance, you may trim a particular part of the file 
to get a shorter segment that you would like your class to hear, or you may want to mix narration with background music. 
 
You can find out more here: 
 

 Editing an existing file: this link will show you how to import an audio file into Audacity® (for example, an MP3 music file), 
edit it, then export the result: http://manual.audacityteam.org/man/Tutorial_-_Editing_an_Existing_File  

 
 Mixing a narration with background music: How to edit a narration to fit the pace of the background music, and fade down 

the music so your listeners can hear your narration. http://manual.audacityteam.org/man/Tutorial_-
_Mixing_a_Narration_With_Background_Music  

 

http://audacity.sourceforge.net/onlinehelp-1.2/toolbar_control.htm
http://audacity.sourceforge.net/onlinehelp-1.2/reference.html#toolbar_edit
http://manual.audacityteam.org/man/Tutorial_-_Editing_an_Existing_File
http://manual.audacityteam.org/man/Tutorial_-_Mixing_a_Narration_With_Background_Music
http://manual.audacityteam.org/man/Tutorial_-_Mixing_a_Narration_With_Background_Music
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Record your own audio files 

Audacity® allows you to record audio files on your computer. You may wish to make various custom recordings for your class – 
both music and speech. Here are some instructions you may find useful: 

 Your first recording: Here are detailed instructions on connecting your audio source (be it a microphone, guitar or keyboard) 
to your computer, and then recording that source with Audacity®. 

 http://manual.audacityteam.org/man/Tutorial_-_Your_First_Recording  
 

 Copying tapes, records (LPs) or minidiscs to CD: Here are detailed instructions on connecting your turntable, tape deck or 
minidisc player to your computer, recording from that device, then editing and exporting the recording so that you have 
separate audio files for each song on the original source ready to burn to a CD or import into a media player such as iTunes. 
http://manual.audacityteam.org/man/Tutorial_-_Copying_tapes,_LPs_or_minidiscs_to_CD 

Sharing a file with your class 

Once you have created a custom file, you can share it with your class in various ways. You can: 
 

 Bring your own laptop to class, connect it to speakers and have your students listen to it. 
 

 Export a file and put it online (for instance, you can use a course management system such as Moodle; to find out more on 
Moodle go to the Moodle DOTS activity; http://moodle.dots.ecml.at/) or share it with others as a podcast (to find out more 
about podcasts, go to the Podcasting DOTS activity; http://moodle.dots.ecml.at/). 

 
To find out how to export a file, visit this link: http://manual.audacityteam.org/man/Export. 
 
Note: Audacity® is often used to encode audio files in MP3 files. However, because the MP3 encoding algorithm is patented and 
cannot legally be used in free programs, you will need to download separately the free LAME MP3 encoder. It is an easy operation 
to do only once. Click on the link below to download and install the LAME MP3 encoder. The first time you export an MP3 file, 

http://manual.audacityteam.org/man/Tutorial_-_Your_First_Recording
http://manual.audacityteam.org/man/Tutorial_-_Copying_tapes,_LPs_or_minidiscs_to_CD
http://moodle.dots.ecml.at/
http://moodle.dots.ecml.at/
http://manual.audacityteam.org/man/Export
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Audacity will ask you to locate your MP3 encoder. From then on, Audacity will not need to ask you again and you will be able to 
export MP3 files easily.  
http://audacity.sourceforge.net/help/faq?s=install&i=lame-mp3  

 

Where can I find more help? 
 
If you prefer using a guide, several guides and online tutorials are available, in several languages. For instance, you can access the 
online manual written by Anthony Oetzmann and Dominic Mazzoni, at the following address: 
http://audacity.sourceforge.net/manual-1.2/index.html  
It includes a tutorial, FAQ, credits, and an index of terms. The tutorial is an excellent place to start with illustrated step-by-step 
instructions of basic tasks.  
 
You can also access a printable quick online reference through the "Help" menu in the Audacity® program or at this address: 
http://audacity.sourceforge.net/onlinehelp-1.2/reference.html  

 
Support is also provided via a growing community of users who cooperate to help each other in various ways. The Audacity® Wiki 
is one of these collaborative support options: http://wiki.audacityteam.org/wiki/Audacity_Wiki_Home_Page 
 

D. Pedagogical considerations and sample activity 
 
Audacity® is an interesting and easy-to-use tool for the teacher to work on L2 pronunciation, listening comprehension and oral 
production. It also allows students to individually and at their own pace, create, listen to, record, and mix audio files on their 
computer. They can then submit their work to their teacher, or share it with their peers, via email or a course management system 
such as Moodle. 
 

http://audacity.sourceforge.net/help/faq?s=install&i=lame-mp3
http://audacity.sourceforge.net/manual-1.2/index.html
http://audacity.sourceforge.net/onlinehelp-1.2/reference.html
http://wiki.audacityteam.org/wiki/Audacity_Wiki_Home_Page
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1. Listening tasks 
 
Using the Copy/Cut/Paste buttons, or the Insert silence button, allows for creative mixing and editing of audio files originated from 
different sources, to develop custom listening comprehension activities, depending on the teachers’ needs and the students' level 
of language proficiency. The Change tempo button from the Effect menu allows for changing the speed of the audio without 
changing the pitch, an interesting effect to play with when dealing with different levels of difficulty for listening to authentic material. 
 
2. Aural discrimination and pronunciation activities 
 
Although research has consistently indicated the importance of pronunciation training in foreign language classes, it is often 
considered as secondary. Teachers might feel that they don’t have the proper training in phonetics to teach pronunciation, that they 
have so much content to cover in their classes that they do not have time to go into the intricacies of phonetics, or that the 
technology needed to work in depth on students’ pronunciation is too cumbersome. Audacity® allows the teacher to easily record 
authentic or pre-edited materials to create specific aural discrimination activities (for instance activities allowing ESL students to 
hear and discriminate between stressed and unstressed syllables, intonation units and contours, or sounds such as “close” [kloz] 
and “closed” [klozd], all of which have strong incidences on the ability to capture the meaning of an oral interaction) and 
pronunciation exercises, adding periods of silence in between utterances as a free space for the student to repeat them. Each 
student, individually and at their own pace, can listen to and repeat the utterances. In order to do that, he/she needs to go to 
Preferences in the Audacity menu and check the "Play other tracks while recording new one" box in the Audio I/O tab.  
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The student can then listen to his/her pronunciation and compare it with the model, redo the activity if he/she is not satisfied, save 
his/her file in his/her portfolio and/or email it to his/her teacher or to peers for peer-evaluation. 
 
3. Speaking activities  
Using Audacity® students can individually or collaboratively record many types of speaking assignments, listen to it for self and/or 
peer assessment, edit their work to perfect it, and submit it to their instructor. The tasks of collecting, saving, archiving, and 
organizing all these speaking assignments is made extremely efficient and easy for the teacher who receives all these audio files 
via email, forums or electronic dropboxes.  
 

Sample activity  
This is a pronunciation activity that is appropriate for an intermediate group of high school or university students studying French as 
a second language. It is based on the song of Etienne Daho “if” (Paroles: Etienne Daho. Musique: Ginger Ale. Duo with Charlotte 
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Gainsbourg. Album "Réévolution", 2003) and can include a listening activity such as the one developed by Carmen Vera Pérez and 
freely accessible at the following address: http://platea.pntic.mec.es/~cvera/hotpot/daho.htm  

This song can be interesting because of the large number of qualifying adjectives to describe one’s personality, but, from a 
pronunciation point of view, because of the repetitive use of adjectives ending in “–if” in a context of tensed articulation. French 
pronunciation is, indeed, characterized by a tensed articulation of its vowels and consonants, compare to other languages which 
produce diphthongs or reduced vowels. This characteristic is sometimes difficult to hear and pronounce for students who learn 
French. In this song, the vowel [i] (maybe the most tensed vowel in French), is continuously presented in a very tensed phonetic 
context (under the stress at the end of a word of group of words, and associated with tensed consonants such as [f], [t] and [s]). “If” 
of Etienne Daho is therefore the perfect song to work on this phonetic characteristic of French.  
 
The learning objectives of this sample activity are as follows: 

- discriminating the muscular tension of French vowels 
- repeating in a controlled context tensed French vowels 
- self-assessing one’s own performance 
- pronouncing tensed French vowels in a more spontaneous and creative context. 

 

Steps 
Learner 

objectives 
Duration 

Class activities and interactions to 
achieve the objectives 

Material / tools Format 

Lead-in Getting into 
the mood of 
listening to a 
song; 
anticipating 
song 
structures, 
sounds.  

15mn Brainstorming: Importance of songs in 
one’s life? Preferences (types of 
music, singers…)? What can we learn 
from songs (cultural content, repetition 
of sounds with rhymes, rhythm, etc.)? 
  

Whiteboard for notes and 
vocabulary 
 

Whole class 
 

Presentation of Getting used 5-10 mn Listening several times to the song, Computer and loud speakers. Whole class  

http://platea.pntic.mec.es/~cvera/hotpot/daho.htm
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the song to the rhythm 
and 
sonorities of 
a French 
song 

without any text, trying to hum along 
to get the rhythm of the song.  

Website of the song: 
http://www.dailymotion.com/vi
deo/x15069_if  

Discrimination Discriminatin
g sounds 
and words 

15 mn Teacher asks students to individually 
note down as many adjectives as they 
can identify while listening once or 
twice again to the song.  
Teacher asks student to identify also 
the recurrent vowel+consonant 
sounds. 
Students share their answers.  

Individual computers; Website 
of the song: 
http://www.dailymotion.com/vi
deo/x15069_if 
Whiteboard for sharing of 
notes 

Individually then whole class 

Listening 
comprehension 

Identifying 
adjectives 
ending in -if. 
Listening to 
the tensed 
pronunciatio
n of words 
ending with –
if. 
Reflecting on 
one’s 
performance. 

15 mn Teacher gives the link to Carmen 
Vera Pérez’s activity and asks 
students to perform the task: listen to 
the song, choose the right word, and 
verify your answers.  Students then 
discuss as a group how they feel they 
performed, the difficulties they 
encountered, their strengths. 

Computers; speakers; Individually then whole class 

Presentation of 
the tool 

Learning 
how to use 

20 mn Teacher demonstrates the basic 
functions of the tool Audacity® on 

Computers; Speakers; 
microphones; prepared audio-

Whole class and individually. 

http://www.dailymotion.com/video/x15069_if
http://www.dailymotion.com/video/x15069_if
http://www.dailymotion.com/video/x15069_if
http://www.dailymotion.com/video/x15069_if
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Audacity for 
repetition 
activities 

his/her computer (opening a file, 
listening, selecting, recording while 
playing another track, saving) with 
audio files he/she has prepared in 
advance. Students can try the tool on 
their own computer, using files the 
teachers has sent via email or the 
course management platform.  

files; handouts with the basic 
guidelines for Audacity 

Pronunciation 
practice  (1)  

Pronouncing 
isolated 
words with 
tensed 
vowels 

20 mn Teacher explains tasks: students have 
to open in their computer the tool 
Audacity® and the audio files the 
teacher has sent via email or the 
course management platform; they 
have to select “play other tracks while 
recording” in the preferences, listen to 
the single words, repeat the word in 
the inserted silence, listen to their 
performance to compare with the 
model, redo the activity until they feel 
satisfied, save their recording, and 
send it to the teacher via email or the 
course management platform. 

Computers; Speakers; 
microphones;  
 
Using the recording and 
editing tools of Audacity®, as 
well as the insert silence 
button, the teacher has 
prepared listening and 
repetition activities with the 
adjectives of the song ending 
with “-if”.  

Individually 
 

Pronunciation 
practice (2) 

Pronouncing 
tensed 
sounds in 
French in a 
karaoke 

20 mins Teacher explains task: students have 
to open in their computer the tool 
Audacity and the audio file of the 
original song the teacher has sent via 
email or the course management 

Computers; Speakers; 
microphones; handout with the 
song lyrics. 

Individually 
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situation platform. They have to select “play 
other tracks while recording” in the 
preferences. They then have to listen 
to the song several times. When they 
feel ready, they can sing along with 
the song, recording their performance 
on another track. They can listen to 
their performance; redo the activity as 
many times as they wish, until they 
are satisfied. They can then send it to 
the teacher via email or the course 
management platform. They can also 
keep it in their portfolio. They can also 
send it to their peers for peer-
assessment. 

Oral production 
with a focus on 
pronunciation 

Pronouncing 
tensed 
sounds in 
the larger 
context of 
oral 
production.    

30 mins Teacher explains task: in groups of 2 
or 3, students choose 3 to 5 
adjectives in the song describing 
one’s personality and ending in –if. 
They use them to create a slogan on 
the theme: “Youth of the 21st Century”. 
Teacher reminds the students the 
characteristics of a slogan: short, 
adheres to one's memory, repetitive in 
nature, rhythmic. Students use 
Audacity® to record their slogan (they 
listen for their pronunciation, the 

 Groups of 2 to 3 
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rhythm, and redo it as many times as 
they need). They can add music if 
they wish. They send it to the whole 
class via email or the course 
management platform. An electronic 
discussion and a vote can then be 
organized to choose the 3 best 
slogans in terms of originality, 
accurate pronunciation, rhythm, etc. 

Reflection Reflecting on 
the activity 
and one’s 
performance 

15 mn Discussion of usefulness of these 
activities. Did they help progress? 
Was it fun? Are they more sensitive to 
the muscular tension of French 
pronunciation? Of French 
pronunciation in general? Can they 
identify characteristics of their own 
language? 

 Whole class 
 

  
 

E. Practical suggestions 

Play and experiment to test the limits of Audacity® 
The more you try recording, editing, adding effects, and mixing audio materials, the more you will find specific uses that will fit your 
needs. Take any audio file, and experiment. It cannot break!!!! However, although the tool is extremely easy to use, you don’t need 
to use all the functions it offers at once. Even at a very basic level, Audacity® can add a lot to your oral class.  
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A creative tool for students 
Look also at Audacity® as a creative tool for your students. Often very at ease with this type of technology, they will find interesting 
ways of using it to create oral productions in L2. We have seen an increased motivation in many students (some at first very shy 
about speaking in L2) when asked to record on their own, using Audacity®, speeches, songs, poems, etc. and being able to edit 
their performance, redo it at will, save it in their portfolio or share it with peers and teachers. 

Computers 

Students will need access to computers to use Audacity®. These can be located in the classroom or in a computer room at your 
institution, or students can use their personal computers for working with Audacity®. They will need good headsets, particularly if 
working in a classroom, to avoid feedback.  

Support for using Audacity® 
When introduced to the tool, students should be with the teacher and other students to get mutual support. You should also 
introduce a few functions at a time, specifically the ones necessary to perform the activity, and leave other functions for other 
sessions. Short handouts with simple and visual instructions help, as well as FAQ sheets, that you can post on your course 
website. Links to more elaborate guidelines (and accessible on the Audacity® website) can be made available to students.  
 

Copyright issue 
When downloading music and/or audio materials from the web, you and your students need to be aware of copyright issues.  
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PART 3 

F. Check your understanding 
 

I can … 
Yes, I can do this 

 

I would like to look 
at that again 

describe Audacity® to somebody else (e.g. a 
colleague)  

 Click here. 

give three reasons for using Audacity® in language 
teaching 

 Click here. 

describe and use basic features of Audacity®   Click here. 

understand the pedagogical gains of using Audacity®  Click here. 

set up a language learning activity using Audacity®  Click here. 

implement practical considerations around using 
Audacity® in my class (experimenting with the tool; a 
creative tool for students; computer needs and 
settings; support) 

 Click here. 
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G. Reflect! 

Here are two possible ways of guiding your reflection. Select the questions that are the most relevant for you.  
  

I. Think about the following issues concerning the activities in this section: 
(To do when you have finished this activity sequence) 

 

 
 

- Has this worksheet given you  
enough information/confidence to  
try out Audacity®?  
 
- Are the different possible uses of 
Audacity explained in a helpful way?  
 
- Will you be able to take this  
worksheet and implement the  
suggestions straightaway? If not,  
what else do you need?  
 
 

- Go to the Explore and share forum, find out what 
other people use Audacity® for. 
 
- Discuss your planned use of  
Audacity® in the Audacity® Explore and share forum 
(http://moodle.dots.ecml.at/mod/forum/view.php?id=36) 
to get helpful tips from experts and teachers. 

* Credit for illustrations: fotographic1980/FreeDigitalPhotos.net 

http://moodle.dots.ecml.at/mod/forum/view.php?id=36
http://moodle.dots.ecml.at/mod/forum/view.php?id=36
http://www.freedigitalphotos.net/images/view_photog.php?photogid=2155
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Reflect on the following questions concerning your use of Audacity®  

as a tool and a resource for your course: 
(To do after your first attempt at using Audacity® in your teaching / your class) 

 
 

- Is this tool/resource relevant for  
your course?  

 Does it fit with your teaching approach and aims?  

 Does it help bring more linguistically and culturally 
accurate material? 

 
- Is this tool relevant for your learners  
(age, level, interest, …)  

 Is the level appropriate for the intended users?  
 

- Can the tool accommodate learners  
with a range of levels?  
 
- Is the language used in the instructions and reference material 
suitable?  
 
- For which skills and activities do you think this tool/resource is 

- After you’ve used Audacity® in your class, share your 
experience in the Explore and share forum. 
(http://moodle.dots.ecml.at/mod/forum/view.php?id=36) 
 
- Share suggestions for new uses of  
Audacity® in the Explore and share forum. 
(http://moodle.dots.ecml.at/mod/forum/view.php?id=36) 
- When you’ve developed a task using Audacity®, share it with  
colleagues by uploading it to the wiki 
(http://moodle.dots.ecml.at/mod/wiki/view.php?id=24)! Our 
forums and wikis are multilingual, so whatever the language you 
teach, please upload your material and you can be sure that you 
will be helping less experienced colleagues. 
 
- Share what you have done with  

your colleagues in your institution.  
Here is the place to brag about it!  
Don’t hide your light under the bushel. 

http://moodle.dots.ecml.at/mod/forum/view.php?id=36
http://moodle.dots.ecml.at/mod/forum/view.php?id=36
http://moodle.dots.ecml.at/mod/forum/view.php?id=36
http://moodle.dots.ecml.at/mod/forum/view.php?id=36
http://moodle.dots.ecml.at/mod/wiki/view.php?id=24
http://moodle.dots.ecml.at/mod/forum/view.php?id=36
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best used?  

 Does it allow for interactive activities to maintain 
student interest?  

 Are there a variety of exercises and tasks that can be 
built with this tool?  

 
- How user-friendly is the tool?  

 Is the tool/resource clear and easy to use for your 
students?  

 Does the tool/resource necessitate some training activities 
for your students?  

 
- Technical considerations  

 What equipment and technical support is required?  

 Is this available in your institution?  

 What on-going costs are involved (e.g. licences for 
software)?  

* Credit for illustrations: fotographic1980/FreeDigitalPhotos.net 
 

H. Explore and share!  

 
Here are some suggestions on where to go from here. Please feel free to add your own suggestions in this section – they can be 
your own lesson plans, ideas, problems, etc.  
 

 Talk to your students about Audacity®. Do they use it? Have they created any audio documents themselves? If you have 
several "expert users" perhaps they can do a demonstration for the entire class. You can discuss why they use Audacity® – 

http://www.freedigitalphotos.net/images/view_photog.php?photogid=2155
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you will learn more about the medium, and the learners will have a chance to share real information with each other and you. 
Please keep in mind that, like with any open medium, audio files inappropriate for the students you teach may appear. 
Therefore, we suggest that you review any presentations beforehand.  

 

 Talk to your colleagues about Audacity®.  Do they use it? Have they created any audio materials themselves? Perhaps you 
can work together to build your own audio-files and oral activities bank, complete with lesson plans and then tailor them to 
different settings and teaching environments. 

 

  One important feature of Audacity® is that it allows you and your students to create your own audio materials in a relatively 
easy way. You can capitalize on your students' use of Audacity® by having them create new audio files that are 
"customized" to your class or your student needs.   

 

 If you need additional information on various aspects of Audacity, here are some further documents you can read: 
 

1. Audacity® Workshop: Use in Teaching Oral Skills by Ghinwa Alameen. Activities in this workshop explore the 
potential of using Audacity® to teach aspects of pronunciation, speaking and listening in the second language 
classroom. http://ghinwa.public.iastate.edu/projects/audacity/workshop.html  

 
2. In French: De l’oral, de l’oral et encore de l’oral grâce à Audacity® by Mireille Spalacci (2008). The author proposes a 

diversity of activities using Audacity® to teach receptive and production oral skills. http://www.cyber-
langues.asso.fr/spip.php?article95 

 
3. Podcasting with Audacity: Creating a Podcast With Free Audio Software by Dominic Mazzoni (originator of Audacity) 

and Scott Granneman - 173 pages. E-book only. Designed to get you podcasting as quickly as possible, with lots of 
tips and tricks to make complicated editing even easier. 
http://www.informit.com/store/product.aspx?isbn=0132366576  

 

http://ghinwa.public.iastate.edu/projects/audacity/workshop.html
http://www.cyber-langues.asso.fr/spip.php?article95
http://www.cyber-langues.asso.fr/spip.php?article95
http://www.informit.com/store/product.aspx?isbn=0132366576
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I. Protecting your students’ privacy 
 

When using audio recordings of your students’ voices, you may wish to consider their right to a protection of their privacy. For 
discussions of privacy issues you can go online to the Privacy forum available at: 
http://moodle.dots.ecml.at/mod/forum/view.php?id=29.  
 
 
 
 

 
This work is licensed under a Creative Commons Attribution 3.0 Unported License. 

Attribution: Original activity from DOTS, Developing Online Teaching Skill, Bite-size Training for Language Professionals. Medium-term 

project 2008-2011 – ECML. http://dots.ecml.at/.  

http://moodle.dots.ecml.at/mod/forum/view.php?id=29
http://creativecommons.org/licenses/by/3.0/
http://dots.ecml.at/
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